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Time & Attendance

Login information

1.

Web browser needs to be Google™ Chrome®.
a. If using mobile Apple® products, the default browser must be set to Safari®.

2. Go to MWxxxx.asureforce.net - your unique URL is your MinistryWorks number (MW#).
3. Save the URL as a favorite on your internet browser.
4. Enter Login ID - the format is specific to each individual ministry.
5. Enter password - the initial password is the word “default” - the employee will be prompted to change
immediately.
MinistryWorks®
by Brotherhood Mutual
Login ID &
Password X
(] Remember ID Forgot Password?

LOGIN

Version 12.4.9.626
©2022, Asure.
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Basic Navigation of Time & Attendance

Home tab

Once administrators and supervisors log in, the Home tab appears. The Home tab offers an overview of
multiple sections.

1. The Dashboard has helpful gadgets that are relevant to completing payroll.

2. The Employee List displays each supervisor’'s Direct Report Employees along with quick links to each
employee’s time card, schedule, and profile.

MmrstryWorks‘ Product licansad to: MinistryWorks, LLC
% | User: tempadmin | (3 Hel It Pager | Gl Sugsgort
Dashboard - Employee List Wednesday, April 27, 2022
0_ Pay Perid Select| | B Search on [ Empioyeehame v | Find Employee Go
Pericd | Cunent (s curert dny) ¥ | viaw Al Name Status  Mext Sched. In Time nnpmm DepartmentiD  Tima... Scha.. Profile
Clark, Stephen OUT  Fri 04:00 PM MIN 3 Open  Open  Open [
Collier, Sara OUT  Thu08:00 AM Ls | 2 Open  Open  Open
“: Calling, Sandra ouT LS 2 Cpen Open Open
" Goniey, Brian OUT  Thu02:00 PM Admin 1 Open  Open  Open
Couk, Tyler ouT Thu 02:00 PM Ps 4 Open Open Open
Comett, Sagha our Thu 02:00 PM Ps 4 Upen Open Open
GCronk, Sarah out LS 2 Open  Open  Open
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Profile tab

e

The Profile tab gives access to employee profiles. These details can be accessed by double-clicking on the row
of any given employee.

Mm:stryWofks' ml:mdlo:lﬂllm%m

FiE 1 Thrs Paaps | Gied Supgwnt

List W | User: sempadmmin | (T) Hedy O

Search On: | Empicyne Name . Find Empioyee Go Status: | Agive v

Hame (-] Unigu... Ststus  Deparime... Department BranchiD  Branch Divislon 10 Divislon Compary 10 Company Supervise... Superviso...

" § MEristryW.., MEristyW... -
> Gk, Slephen HANSHE HADASE Actioe 3 LN H Evoa Tiré 000 Evo Time MNEVOT Evo DEFALLT DEFALT HOUHLY]
»  Collier, Sara PROOTG  PROOTE  Active 2 Ls 200 [Eva Time 1000 it MWEVOTL... ey DEFALLT DEFALLT HOURLY

Ev Time Evo Tims |

3 1 a I

» Coling, Sandm SOSI04 | SOEIM  Adve 2 s 200 Evelime 1000 W wevom.. U™ peenar peraur woumy™
Evo Tine Evo Time

Conley, Brian SAITI0 SA3TIS  Acte 1 Admin 00 Eva T 1000 MWEVOTL... DEFALLT  DEFAULT  HOURLY

i - Evo Time Evo Time
MiristyW... MRSty
* Cook, Tyler KOTOSS  KOTOS6  Actve 4 Ps 200 [Evo Time: 1000 MWEVOTI.. i DEFALT DEFAULT HOURLY
Evo Time Evo Time
. MhristyW... MiristyW... -
*  Cometl, Sasha SASHA  SASHA  Aclive 4 P3 00 Eve Time: 000 Evo MWEVOTL.. £vo DEFALT DEFAULT SALARY
RIS BTSN e
. N .
e oo
® 3 r 1 e /] ; | k T ] 1 L I u 1 ¥

Schedule tab

e ________________J

The Schedule tab allows for the creation, editing, and assignment of schedules.

MirustryWorks*

e T T N T

List | Master Sk |

SearchOn: | Employse Name v Find Employes Go Siotus: | Active v

Hama ] Etatus Dapartmant Pay Groap Shift Echadula Tampla...  Schaculs Tamplats Dasz. .. Dase
Clark, Stephen HADSDE Athver 3 HOURLYPT WV AP_EP MIWF dp-Bp
Cailler, Sara PFRIGTE Acthve 2 HOURLYPT M-F A-12 WP A-12
Colins. Sanara SG5I04 Acthve z HOURLYPT
| Cortey, Brian SAITY Active 1 HOURLYRT M-F 2P - P MF 29 - Bp
Coak, Tyler Kevmasa Acthe 4 HOURLYPT ML.F 2P AP MF2p-Bp
Comets, Sasna SASHA Agihve 4 SALARY M-F 2P - 8P WF -8
| ron, saran JoB03 Acthe 2 HOURLYPT weizs ;2 Wa1258.12
awling, Syivia TEIEY Aettve : | MOURLYFT
Eler, Robert SC0758 Acthe 1 HOURLYPT :-';mapsaa. WS 4p-8pS Ba -12p
Engleking. Kafnern HESSDS Acthe 1 PT SALARY M-FTA- 2P MF Ta-3p -
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Time Card tab

The Time Card tab provides access to time cards by double-clicking on the row of any given employee. Editing
and approvals can be handled in this area.

MiristryWorks®
List | Browse Exceptions | Brawse Approvais | Global Approval | Giobal Re-Calc | Global Punch | Giobal Misc Fay | Configure Prozy flat | Adsar: Semanaein | ( g On 11is Fagn | Ge Sonpat
Search O Emgioyos Name - | Find Emplayes Go Staus: | Active bl
| Name D Status Bepartment IS Departmant Pay Group Time Entry Type
Clark, Staphen HADSEE Actve 3 MiN HOURLYFT Funch
Coliet, Sara FROGTE Actve 2 LS HOURLYFT Funch
| Collins, Sandra S05304 Actve 2 L3 HOURLYFT Punch
‘Conley, Brian SANTID Actve 1 Adamin HOURLYPT Purnch
| Cook, Tyler KOT0sE Actve 4 Fs ROURLYFT Punch
Cormett, Sasha SASHA Actve 4 PS SALARY HoursEntry
Cronk, Sarah Joes Actve 2 LS HOURLYFT Funch
| Darfing, Syhvia T8 Actva 2 LS HOURLYFT Punch
[Eler, Robert 200758 Actve 4 F3 HOURLYFT Punch
Engieking Kathern HEGS0S Acive 1 Adrmin PT SALARY Punch
Epperson, Johary OMaIT et 4 [ HOURLYPT Punch )
“ oa . 2 3| * ¥
-] e f i m r =] q r u

Accruals tab

e

The Accruals tab shows available balances, history, and details of the employee’s accruals. These details can be
accessed by double-clicking on the row of any given employee.

= Pratecenzes | Leg OF
Mm:stryWor_ks Froduct licanaad to: MinistryWorks, LLC
List | Glokal Allotmerat Wt | User; tempadmin | () Help O Thes Pagu | Gl S
Search On: | Erpioyes Name v Find Employoe Co Status: | Actve .
Nama (1] Accrual Group FTO Siek Vacation Stanm Departme...  Dapartment Branch D Branch Division D Division
_ Mkt
| Clark, Stephen HAD59% Diefault 16,00 1500 B3Ca Active 3 M 200 Evo Time 000 g
| Colles, Sara FROOTE Defaul 144.00 24.00 Baoo Aive 2 LS 200 Eva Time 000 Tire !
Calins, Sancra 35304 Defaull 1600 0.00 1200 Aiive 2 L3 200 Evo Time 000 gk e
Minist\
Conley, Brian SA7IE Diefault o0 24.00 120.00 Acihve 1 Adin 200 Evo Time 000 e
Cook, Tyer KOT056 Datault 4.00 15,00 12000 hcive 4 ] 200 Evo Time 000 _I_Im:M
| Comedt, Sasha SASHA Full Time Acoruals. (1] 000 000 Acthve 4 P3 200 Eva Time 000 Tire
Maniztran
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Leave Request tab

The Leave Request tab allows for the approval or denial of leave requests made by employees. Supervisors and
administrators can also create leave requests on behalf of the employees in this area.

Freforences of
MinistryWorks® mnmu-m&mﬁmm

Liat | Manm | Wask HiEe | User: beempairmin | O3 E

Roguocts
2 Pending
bl Approved & Namo (=] Hours. Is Partlal Day? Requested D, Siatus Pay Type Commants Reasen
|| Denlet @
L Den Clak, Stephen HADSEE 10 Mo M22202  Porcing VACATION
Start Date
= |§| Cank, Tyler KOTOS6: 800 Mo 0410872022 Approed PTO NA
412082
PO request AF
End Date Darling, Syha TEE B0 o MIOS202Y Appemived FID o

(oo [ 5]

To view leave requests for al the
datea do not specity Start Dats end
End Date,

Reports tab

The Reports tab offers reports ranging from schedules, time detail, and many other options.

. '-nm-aml Log o
Minist ryWorks
Schedule  Tirme and Allendance  Persornal | Labor Analysts | Benefit Thre | Polnts | Configuration | Favorites | User Defined Useer: Sem padmin | ) Hek
Schodulo Reparts:
Schasals Rostes by Aasgnmant [Sstomis]
3cheduls Rostes by Esplopes [Ewatemizy]
Daiy Screcus by Arval Tame (=]
DuryiTeam 62 Dt Scteduied [Customige]
VENANS Detwean BUASHT 394 Sehedule =
Vanasce herwesn Budget 20d Actid [Cxmnme]
Schadule Audh Report

Emslopes Covirsge Rapsrt
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Payroll Preparation

Time Card Exceptions (Home - Dashboard)
Missing Punches

1. Period - select the time frame for the punches that you want to review.

2. Review Missing Punches (MP) - click on the Red pie slice. This will take you to the employee(s) who are
missing punches.

3. All employees that have missing punches will be shown.

4. Click on Report Date and address all missing punches prior to the current day.
Note: Today’'s punches will also be shown and do not need to be resolved.

5. Click on Open to navigate to an individual's time card to resolve missing punches.

List | Erowse Exceptions [ Browse Approvals | Global Approval | Glebal Re-Cale | Global Punch | Global Misc Pay | Configune Proxy Filler | User: tempadmin | (0} Hafp ¢
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The employee’s time card will be displayed.

1. Ensure you are in the correct pay period.
2. Manually enter missing punches.
3. Click SAVE after making changes.
4. Click CLOSE to close the time card.
File » Windo! 4 Action » Help =
3 SMVE REFRESH CLOSE RECALC PUNCH TRANSFER MISC PAY ERASE DELETE CVRCHART TSREPORT WIEW MINS -
Department 2. Early Leaming Center Pay Perlod 05152022 - 0521202288 < »
Name ‘ g b l =l < Team Aux Staff : Audiiary Staff Pay Group HOURLYPT ; Hourly PT Employees
Comment |
Sun 05/15 ® Man 05/16 © Tue 0517 ®@ Wed 05/18 ® Thu 05/19 ® Fri 05720 & Sat
In I oss0am B8 orooam B oes2aM EA = El
out B o0212PM fi6] o212PM 'l .l o B i
In I = | (=] = ]
out = ] H ] = =
Misc Pa

When all missing punches have been resolved, navigate back to the Home tab.
The Red pie slice, within the Time Card Exceptions gadget, will have disappeared.

Additional Exceptions

1. Not Scheduled (NS) - Yellow pie slice. If schedules are not being used, this will be the default color of the
pie. If schedules are being used, this means an employee punched on a day they were not scheduled.

2. Early Arrival (EA) - Green pie slice. If schedules are being used, this indicates that an employee
punched in early.

3. Late Arrival (LA) - Pink pie slice. If schedules are being used, this indicates that an employee punched
in late.

4. Early Departure (ED) - Grey pie slice. If schedules are being used, this indicates that an employee
punched out early.

5. Late Departure (LD) - Purple pie slice. If schedules are being used, this indicates that an employee
punched out late.



MinistryWorks®

by Brotherhood Mutual

Time Card - Hours Calculation Detail

From the time card, click F7 to view the applied rounding and/or meal deduction rules by pay period.

1. Actual Punch In and Punch Out times.

2. Rounded Paid In and Paid Out times.
3. Rules Used applied.

Employee
For Pay Period Friday, J to Friday. July
Punchbhn  Panch Out

Repot Date  Type Wt P s Pad 00 Sheain Sened Out Team

BreakMn  Paa Sresk Min Ext I Exe OUtsob 1 Py Typeia T3 BT CF2 O3 OTH premure Ommertis PPAHm  RulesUses
b 0622022 P GSODPM  OG36PM  O51SPM  CGS0PM F o o N nEG 125 000 000 000 000 000 000 000  Rounang
b DE20022 P 58PN 0633PM  0500PM 0530 PM F a 9 NS REG 350 000 000 600 000 000 000 600
booR2EREE P GESTPM 101TPM E4SPM 1015 PM F o o NS

Rounding
Reanding

REG 550 000 000 000 000 O

L1 oo

The above setup has a rounding that rounds each punch to the nearest 15-minute interval with 7 minutes
being the mid-point.



MinistryWorks®

by Brotherhood Mutual

Editing and Adding Punches to a Time Card

At times, supervisors & administrators may need to edit an employee’s existing punches or add new punches
on their time card.

1. Click on the Time Card tab.
2. Double-click on the applicable employee to access the time card.

MinistryWorks® 0

Collins, Sandia Camment |
Cenley, Brian
Wed 06101 © Thu 0602 @
o_ n 0200 M -.UJHUFW- =
Out 05,00 PM =] | as.00pm =5
n 1 =
out =] =]

Examples:
Example A: 6/1 The employee punched out at 6:00 PM but ended up staying until 7:00 PM.
1. Edit - click on 6:00 PM cell and change to 7:00 PM.
Example B: 6/2 The employee punched in at 2:00 PM but was not needed until 5:00 PM, so they went home.

When they returned, they punched in again for the day at 5:00 PM. The employee then forgot to punch
out at 10:00 PM.

2. Delete - click on the 2:00 PM cell and click delete on the keyboard.
3. Add - click on the next available cell to enter 10:00 PM.
4. Click SAVE - all edits are indicated with a red triangle until SAVE is clicked on the time card.

Before edits: During edits:

Help ™ 4 * Window¥ Acion™ Help”

File ™ Window ¥ Acfion ™

TRANSFER MISC PAY

SAVE REFRESH CLOSE RECALC = SAVE REFRESH CLOSE RECALC TRANSFER MISCPAY E

Comment | Comment |
Wed 06/01 © | Thu 06/02 . | Wed 06/01 © Thu 06102 © l
In | 02:00 PM B ozooem B In | 02:00 PM = I" o [}
out ' 06.00 PM | | 0500 P = ' out For00 pmo | ' 0s:00PM [ | |
| in - - :.In -jr';u:nnpme-:
= = o | -}l -]

When all punches have been resolved, navigate back to the Home tab.
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Leave Requests (Home - Dashboard)
Approve/Deny/Delete Leave Requests

1. Period - select the time frame for the punches that you want to review.
2. Click on either the number of Unapproved Leave Requests or the date link.

LEAVE REQUESTS GaOXxX
o Peﬂud:‘ Current o x ‘

Unapproved Leave Requests: 1 l

Richmond, Amber has requested 5/11/2022 ofi. Pending

K "’ M 1-1 of 1 items

The Leave Requests tab will open.
Edit Start Date and End Date to include the full pay period (or desired time frame). Click View.

2. Click on a specific employee that has a pending request. Multiple employees may be selected.
Note: When a leave request is approved, denied, or deleted, an automated email is sent to

the employee.
3. Select APPROVE, DENY, or DELETE LEAVE REQUEST. ** Only administrators have the Delete function.
Note: When a leave request is approved/denied/deleted, an automated email is sent to the employee.

List | Month | Week

Once a request is approved, verify that the request transferred to the time card.

Note: Any leave requests submitted or approved on the day of, or for days prior to the requested day,
will not transfer automatically to the time card. The time card must be saved again.

Click here to go to the Time Card Validation section.
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Calendar View

The Calendar View allows you to see all requests for each day for the entire month.
1. Click Month.
2. Check or uncheck desired request types: Pending, Approved, or Denied.

List | Month | Week

Search On | Fmpioyee Name ~|| Find Employee Go Sts

Requests
Pending
o Approved & Name ID Hours
U4 Denied ] ! |
-— 1295 .00
Start Date : -
— 1256 .00
06/08/2022 ! |
— 1258 8.00
End Date
s — 1256 a.00
w9

The Calendar View will be displayed.

Approved requests have a green check mark next to the employee’s name.
Pending requests have a yellow P next to the employee’'s name.

Denied requests, if selected, have a red X next to the employee’s name.

HwnN =

A red box indicates the current day.

List | Month | Week Filler | User: tempadmin | (T) Help On Ths Page | Gl Suppd

Sunday Monday Tuesday Wednesday Thursday Fricay Saturday A
20 n (e &t ad 2 4
| Tt g E— & e S B - B ——
oBDE2022 | L omatind ll-—_ Do B Lowm S
P T L Lot Y b Qromm te
P Jure 2022 e BF emas wes & v e [ JR————
—— = ==
SuMo TuWe Th Fr € s ' e, e "
§or— — M —
B o3 W 1 2 3 !l—-—l-— Lj_—_ s Gutn vy
s e S — — e S——
A S—
5B 7- LI} i
— = o
113w oE e T §__-_ - p— R L p— . J— | p— I
1 20 ;2 2@ 24 %—— E_-- o . @ e -
B — QUorane bns [ - LR Py S
® o om om w SO
18 il 22 24 28
" & i 8 i - B i W B s m—— B — - & e ¢ m—— e " —
N N - N :-ll-_ § = = T iy - G T — Tam S
P — e — [ [
A e e
Requests T
2% g 28 28 2
B4 Pending © ] e —— — - oo b L
mgd' gt L — L — b — .—
| a—— . — o — e — - — A
4 oenies @ [y — e -— - gy
— e — e -
= ——
3 4 95 ] ¥ 8 £}
[ Iselect All Panding Raquasts :___— by S ey
[ ] e B — G S
APPROVE CHECKED S . iy
- -
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Calendar View - Approve/Deny Leave Requests

1. To approve or deny from the Calendar View, click on the white box next to a pending request. A blue
check mark will appear.

2. To approve all pending requests, click Select All Pending Requests.
3. Once applicable requests are selected, click APPROVE CHECKED or DENY CHECKED.
4. To exit the Calendar View, click on List.

Leave Request
a € ¥
Sunday Manday Tuesday Wednesday Thursday Friday Saturday
i T ™ » I + ; .
T © Clo e o T P
 —
4 June F02z 13 s o
Su Mo Tu We Th Fr Sa
™ » »n 1 T 3 ‘ 5 '] b3 ] b B "
1 R B o ¥
5w rn 5w om oy A e i_‘:—
wow oW oW W W -
L B
% @ ow o owmow o1 o2 0 et s = ® B s "
— o [ —— e — T
3 ks . . ' . [ Bl :__-
Requests
[ Pending EE) 2 D s z‘-._ x“_ =
Approved & :..... — ey — - - !—-— e
; - — - - e
[ | zalact AN Ponding Raguasts i 3 # E Y ) o
;.- — !:-.— - — !.- — B
o — T — —— — - —
APER HED e = — = -
. =
3 & —
Dlorsates [ oimeans P e
Lk —— — I_L.-..—.n.— L] .,_:_... |—L. —
e == S — e

Once a request is approved, verify that the request transferred to the time card.

Note: Any leave requests submitted or approved on the day of, or for days prior to the requested day,
will not transfer automatically to the time card. The time card must be saved again.

Click here to go to the Time Card Validation section.
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Edit Leave Requests

At times, supervisors and administrators may need to edit leave requests on behalf of the employees.

From the Leave Request tab, double-click on the request that needs to be edited.

Qates. 90 o spECAY SEaN Daté 300
Endg Dt

The Leave Request box will appear. Make edits as necessary.

In the example below, the employee took a full sick day instead of a partial vacation day.
1. Pay Type was changed from VACATION to SICK.
2. Hours Per Day was changed from 4 to 8.

3. Click SAVE AND APPROVE or SAVE AND CLOSE. If the latter, the request will remain in pending status
until approved.

Original: Updated:

e Lo st AT AN G G SNE AT ATHENE VIFW ALK

Genaral Goneral

Emplojes | Clari, Stephen - Employee clark, Stephen

Rogquestod Date| 06702022 = Roquested Date | 062012022 |H|

Leave Request Datus Leave Reques: Nates

4 Jue 203 [ oty 82 o4 Pt > 4 pana 2022 = Sy a2

Su Mo TuWe Th Fr Sa Su Mo TuWe Th Fr 85 Su Mo TuWe Th Fr 53 Su Mo TuWe T Fr Sa | Su Mo TuWe Tn Fr
L | : voa o ow s s T L
R I T T

B oe 1t ox v owom| x4 % & T

e I R T B T v ow o®o@n L e L LT T T S ST

.
a “

B o® oM OB OB oMW | T OB B OE N BB NN M HBE N W M M DB M B W oMW BB oD
E »

% oz on @ 8 8 5 nuon at n o ® m B n ® o x4 8 8 & . o om o ow o
: HE ] TR 1 T T S R T ¢ roa a1 w3 . e oroa
vyt [ vacAon = T = e B [ B
ToBuPsd | Tme CRDute ) ToBaPad | TmsoHOms |
Mours PerDay | B 2 EBL2TRE
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Create Leave Requests

At times, supervisors and administrators may need to create leave requests on behalf of the employees.
From the Leave Request tab, click on NEW LEAVE REQUEST.

I,

Search On [ Ergioyme Name +| | Find Empioyes | @0 ®oma) actwe -
3 Pendeg
B #eproved @ Harma L] Hers s Partial Bay? Huguested Date  Status Pay Type Commarts Brazon
Denisd & <
St ki 1 nog Lt Loy Apgroves WACATICN
- Nﬂ | — — 1254 400 L] Lo b d Apgrewed WACATION
e
e L] ann L gLl Panding POO
[End Dwim
—— - mn BOn L] Lol d Approwed BRTHIAY

The Leave Request box will appear.

Select the employee.

Select Begin Date and End Date. If applicable, check or uncheck Skip Weekends and Skip Holidays.
Select Pay Type.

HwnN =

Select Hours Per Day and, if applicable, the Minutes (15-minute increments).
5. Select SAVE AND APPROVE (or SAVE AND CLOSE if you do not wish to approve the request now).

Note: When a leave request is created, an automated email is sent to the employee and their
direct supervisor.

R ] 1
e [T 0] g Bowe

o s
Leave Requast Dates

“ dovl LI | o i LB | il >
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] r ] T s
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" noa n @B owonwn owowm n @S 8
M n » n »

" E
n x ¥

v o2 3 & s s 1/ £ s ¢+ s s ® w/| 3 4 s e 1
Pay Type VACATION ‘, o Roason e

Hours Per Day _4. Minutes | © vl

E ] ¥ W M 4 3 4 ® ¥

Once a request is approved, verify that the request transferred to the time card (pg. 18).

Note: Any leave requests submitted or approved on the day of, or for days prior to the requested
day, will not transfer automatically to the time card. The time card must be saved again.
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Time Card Validation
Once a leave request is approved, the time card must be verified to ensure that the request transferred.

Note: Any Leave Requests submitted or approved on the day of, or for days prior to the requested
day, will not transfer automatically to the time card. The time card must be saved again.

From the Time Card tab, double-click on the employee for whom the leave request was just approved.

N T T ] I e

List | Browsc Exceptions | Browsc Approvals | Global Approval | Global Re-Cale | Global Punch | Global Misc Pay | Configure Proxy

PO | GRSl

SAVE REFRESH CLOSE RE-CALC TRANSFER MISCPAY ERASE DELETE CWVR CH

Neparfme

Comment |

- Thuoe/1is @ " Frioeir @ . Satoe/is @ .
In _ B B H
o | _1 _1 U

Misc Pay

LRHrs | 08.00 VACATION

(RHrs | ' 0800VACATION
(RHrs | - |
LR Hrs I

(RHrs |

(RHrs

LR Hrs

Total Hrs
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After the time card has been saved, the leave request hours will populate in the Total Hrs row.

SAVE REFRESH CLOSE RE-CALC PUNCH TRANSFER

MISC PAY ERASE DELETE

Departme

commen |
. Mon0523 ©  Tue0524 O Wed0525 © |
In 08:11 AM [ o0s:20am ns B
Out os46Pm [ oamem =]
n B - | E
o | | .. ] 1
| Misc Pay .00 VACATION
Total Hrs nan3 nanz v na nn
Reg Hrs 08.00 08.00 .

oT 00.03 00.02

When all pending leave requests have been resolved and all corresponding time cards have been validated,

navigate back to the Home tab.
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Time Card Approvals (Home - Dashboard)
Checklist

+ Missing punches and other time card exceptions have been resolved.
+ Leave requests have been approved or denied.
+ Time cards have been updated to include all approved leave requests.

Time Card Approvals

Period - select the time frame that you want to review.

2. Awaiting Employee Approval (optional) - this is for accountability purposes only and is not required to
process payroll. If required, employee approvals must be done prior to supervisor approvals.

3. Awaiting Supervisor Approval - click on the blue number to approve time cards.
Note:
* Once atime card is approved by a supervisor, it is locked.
+ Edits cannot be made and employees cannot punch in or out unless the time card is un-approved.

+ Because of this, supervisors should not approve time cards until the employee has punched
out on the last day of the pay period.

TIME CARD APPROVALS

0 Pen’od:‘ Previous " View All

My Approvals

&

Awaiting Employee Approval

Emploves Approved e

|Awaiting SUEWiSOF AQE gval

Supervisor Approved

] 5

All Approvals

Unapproved 50
Approved 25
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A time card summary will be displayed for each employee, 10 summaries per page. Review the following:
1. Dates worked.

2. Time in and Time out.
3. Total hours worked.
4. Pay Type (regular, holiday, vacation, sick, etc).
5. Department transfers (if applicable).
6. Pay Type Summary information.
Employea: ID: 1322

Department : Donor Services

Date : 05232022 - DE/0T/2022

o Time In% Ovr h&iw Out ExOut  Ovr Out Hours  Pay Type | Company Division | Branch Department Job
-osrzaa

022 6.00 PDO

losi242022 08,30 AM 05.00 FM .00 Regular

05252002 0830 A8 Ns T AN 3.45 Regular

(S8022 08.30AM NS 0503 P8 B .05 Regular

OSITR022 0830AM NS 502 FM £ 03 Regular

05030022 500 Holday

|08/3112022 08.30AM NS 05.03 PM 8.05 Regular

|0i01/2022 08:30AM NS 05:03 PM 8.05 Fegular

|0Gi0212022 08.30AM NS 0501 FM 602 Regular

Lt el vrd 05.30MM NS 01504 FM 607 Reqular

|oaivaz022 GEMAM NS 0431 FM 800 Regular

io&omoez 0815AM NS 0453 PM B.13 Regular
Total Hours for Period! :91.85 o Pay Type Summary

T Haurs Pa; Hours.

Employes Approved f;gam 75 45 mﬁn?:rpa 500
Supervisor Approved

7. Ifinformation needs to be updated, click on EDIT TIME CARD. Make any needed adjustments. After click-
ing Save, it will return to the time card summaries for continuation of the approval process.

Once all information is accurate, check the box next to Supervisor Approved.
9. Click Submit.

Note: The Check All function is not recommended as detail accuracy may be overlooked.

Slobal Punch | Global Mise Pay | Canfigurs Prowy e | Uner: tempadmin | (5 Help On This Fage | Gad Sups

Employee: s S 1D: 1322

Departmant : Donor Services

Date : 05232022 - 0607/2022

Date Timeln (Exln  Owin  TimeOut  ExOut | OviOul  Hours PayType  Company Division Branch Department Jab
[ B00 FOO
0SA022 GH30AM NS 0500 PM 800 Regular
05752022 0830AM NS 1157AM 345 Roguiar
05262022 0BI0AM NS 0503PM 805 Regular
SATR0EZ OEI0AM NS 0502 PM 803 Reguiar
053072022 500 Holiday
ONME22 DE30AM NS O503PM 505 Regular
OE012022  OB30AM NS 0503 PM 805 Reguiar
06022022 0S30AM NS 0501 PM 802 Regular
06032022 0SI0AM NS 0504 PM 807 Roguiar
06062022 GS01AM NS 43 PM 800 Regular
(06072022 0845AM NS 0453PM 813 Regular
Total Hours for Periodl -91.85 Pay Type Summary
Pa Hours P Hours
0 Employee Approved h 'nsrcw 1545 Hoﬁme 800
perviacr Sopiond OVERTIME 040 PDO 800
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To advance to the next set of 10 employees, scroll to the bottom of the screen and click on the arrows in the
bottom-right corner.

Employee; s, ID: 1352
Department : Custamer Experience

Date : 05/16/2022 - 0513112022

Date [Timein [Exin  |Owin TimeOut  ExOut OwOut  Hours |PayType  Company Division  Branch Department Job
053072072 .00 Holiday
Total Hours for Period? |2.00 Pay Type Summary
" Hours | T Hours
Employee Approved H E?[m 800 s
Supervisor Approved

When all time cards have been approved, the payroll is ready to be processed.

For payroll processing instructions, access Section 2 - Online Payroll Processing of the Evolution Training Manual.
HCM clients, click here to access the HCM manual.

Note:

Payroll Export File will be needed for the following situations. If this is required, specific instructions will
be provided.

« Two groups, different pay periods, same check date.

* Hourly paid on 15th for work completed from 23rd - 7th; salary also paid on the 15th for work from
1st - 15th.

+  Employees who have multiple pay rates tied to multiple departments.
+ $15 for work done in the Admin department; $13 for work done in the Janitorial department.
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Common Time Card Edits

Holidays
Adjusting/Removing Pre-Populated Holiday Hours

Holiday hours are not visible on the time cards until the actual date of the holiday.

Occasionally, adjustments may need to be made to the number of hours awarded to an employee on their time
card.

1. From the employee’s time card, click on the Misc Pay line. The Miscellaneous Pay information will open
below.

2. Click ADD ROW - a new line will appear at the top of the Miscellaneous Pay grid.

3. Under Day - change the date in the new line to match the date in the original holiday pay line.
4. Under Pay Type - click the three dots; choose Holiday.
5

. Under Hours - enter the correct number of holiday hours. In this example, “0” was entered to remove
the holiday pay completely.

6. Click SAVE - the original holiday pay line will disappear and be replaced with the new line.

6 54 RE-CALG THANSFER MISTRAY  ERASE UELETE CWROHART WEEKVIEW ISREPORI  VIEW MING 4 Profile [ Schedu
e [ e [ > N S i e

Sun4M0 @ Mon 04111 & Tus 04112 @ Wed 04113 @ Thu(4i14 © Frid41s © Sat04116 @ Sun 0417 @ Mon 04/18 @ Tue
In [ orasam  [HE ¢ omatam W0 osasaM  [E| 0 o745aM [HE O ouooPu ns =] I orzoam [0 or4s
Out B os2crm e osaePm G osorw P 0xeaPm PO 0200 PM . = I osaaPm G 05:42F

in = [ ] [ = = = " |

out = | = | = B [ = =

Misc Pay 4.00 HOLIDAY e

L] L]

Ex Rea | JobiD Gomments:

Holiday hours are pre-populated on time cards for applicable employees. This is driven by the employee’s
assigned Pay Group.

« If an employee's time card does not have pre-populated holiday hours - but should, contact your payroll
processor.

+ If several employees need to have holiday hours adjusted on a consistent basis, contact your payroll
processor.
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Missing Holiday Hours
Holiday hours are not visible on the time cards until the actual date of the holiday.
If an employee should receive holiday pay but it is not populated on the time card:

1. From the employee’s time card, click on the Misc Pay line. The Miscellaneous Pay information will open
below.

2. Click ADD ROW - a new line will appear at the top of the Miscellaneous Pay grid.
3. Under Day - add the date of the holiday that needs to be added.

4. Under Pay Type - click the three dots; choose HOLIDAY.

5. Under Hours - enter the number of holiday hours.

6. Click SAVE.

Flle » Window » Action = Help » Time Card:

REFHRESH CLOSE RE-GALG  THANSFER MISC FAY ERASE DELETE ©CWH CHART WEEKVIEW 135 HEFORI

NS A Profile 3 Schedu

= Department 5 : Custodial Pay Period 07/03/2022 - 07/16/2022 [§ <
Name | . | = le> Pay Group HOURLY PT : Hourly PT Empic

Sun07/03 ©& Mon 07/04 @ Tue 07105 ©® Wed 07/06 ® Thu 0707 ®& Frio7iog @

In = = = [ =
out = ] = | =
wr O

Day Pay Type Hours Amount Department Ex Rea  JoblD Comments

mowz @) |[ool)- N0 @ (ov [ |- W[ |-

Holiday hours are pre-populated on time cards for applicable employees. This is driven by the employee’s
assigned Pay Group.

« If an employee’s time card does not have pre-populated holiday hours - but should, a new Pay Group
may be needed.

+ If several employees need to have hours adjusted on a consistent basis, a new Pay Group may also be
needed.

Contact your payroll processor to have additional Pay Groups added.
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Miscellaneous Pay

Adding Miscellaneous Pay to a Time Card

Miscellaneous pay adjustments may need to be added to time cards for certain instances, such as bereave-
ment or jury duty.

1. From the employee’s time card, click on the Misc Pay line. The Miscellaneous Pay information will open
below.

2. Click ADD ROW - a new line will appear at the top of the Miscellaneous Pay grid.
Under Day - change the date to the correct date (it will default to the first day of the pay period).

. Under Pay Type - click the three dots; choose the applicable pay type (BEREAVEMENT, JURY DUTY,
or UNPAID).

* This method should not be used for PTO, vacation, or sick time. The preferred method for recording
these types of leave hours is via the Leave Request tab.

5. Under Hours - enter the correct number of hours.
Click SAVE. The hours will populate in the Misc Pay line for the applicable day.

Fie ¥ Window ¥ Action ¥ Help™ Time Card: Clark, Steph
O SAVE REFRESH GLOSE REGALC PUNCH TRANSFER MISCPAY ERASE DELETE CVRCHART WEEKVIEW TSREPORT VIEW MINS & Profile [ Schedu
PR Department 3 - MIN Pay Period 06/16/2022 - D&/30/2022 5 ¢ >
Name Clark, Stephen Pay Group HOURLYFT - Hourly FT Employees

Comment | |

Thu 06116 @ Frios7 © Sat06/18 @ Sun06/19 @ Mon 06720 © Tue 0621 G Wed 06122 ® Thu 0672

In = 04:00 FM = B = 04:00 PM [ | = 04:00 FM B

Out . - . we - . - 08:00 PM - = 0800 PM | -] .

n : H | = = ] ] | = |

o | = = 1 1 1 ] ]

Misc Pay o

Total Hrs — g s . 04.00 o 04.00 o
- Reao Hrs ; : : : 04.00 o 04.00 =
Day Pay Type H Amount  Depariment Ex  Rea  JoblD | — . '

ours
wie @ [l w @ w» [ |- mE[ -
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Deleting Miscellaneous Pay from a Time Card
If miscellaneous hours need to be removed after they have been manually added:

1. From the employee’s time card, click on the Misc Pay line. The Miscellaneous Pay information will open
below.

2. Click on the miscellaneous pay row that needs to be removed.
3. Click DELETE Row.
Click SAVE. The miscellaneous hours will be removed from the time card.

;cmﬂemen o Deparirmset 3 MIN 3;;9.-&-; Bé0, T-wmﬁ:ue

Mon0BOT ®  TueD&D? @ wed 0803
In [EEI U |
on  soem N
In
our

P

Tue 0808 @  Wed 0810

Thy G844 Thu 0811

=
=
Misc Pay B.00 BEREMVERNT
Total Hrs e F N =N 00 5 F 4 e " = o N
] e ! ! | ! | |
am

ENEMNo.

© ]
] =
1 =
1 =
B =

oz
o3
o4

1
=3 WU T B
1
I
t el el
=1 N R BT
A R BT
U AT i
o ol il ol o
I
ol e o
1

it
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Leave Requests
Leave Request Hours are Missing on a Time Card

If leave request hours are not shown on the employee’s time card, one of the following scenarios has happened:
* Aleave request was either not created or not approved.
* Go to the Leave Request tab and look for the request.
+ If arequest does not exist for the date in question:
+ (Click here for instructions to create and approve the request.
+ (Click here to validate the time card.
« If arequest does exist for the date in question, verify that it was approved.
+ Click here for instructions to approve the request.
+ (Click here to validate the time card.
+ Aleave request was created and approved, but the Time Card Validation step was not completed.
+ Click here for instructions to validate the time card.

Remove Unused Leave Request Hours from Time Card

If leave request hours are shown on the employee’s time card, but the time was not taken, the leave request
should be deleted.

Click on Leave Request tab.
Edit Start date and End Date if needed.
Highlight the request that needs to be removed.

A wn =

Click DENY. Enter a supervisor note in the popup box. Click OK.

N T T e

Filtes ey O Tho, Page: | (e 5

List | Momth | Week Ucer: tempadein | (0 §ielp Or
30Iﬂ=h0l1| Employes Name .|| Find Employee | Go Stalus| Actve | o
Pending APPRON Y
Approved @ Hame .} Hours Is Partial Day? Requested Date  Status Pay Type Comments Reason
Denied @
O [——— 9 1265 £00 No 011182022 Approved POO
Start Date
2 TE o o— e 1 i
[ cazaz0zz ia 265 500 No 0Tz Approved FDO
—_ P —— 1265 800 No 072072023 Approved POO
End Date
e —————TE B 1265 800 No 2172022 BIRTHOAY
om0z |
. - 1201 800 No 0672472022 MACATION
“ - — s 800 No oeT0z2 VACATION family vacation
V""“;"ﬂ‘mgg&:‘ O | — s 800 No 06/28/2022 VACATION
End lnte - — 1115 200 No 06202022 VACATION

(continue to next page)
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You must also verify that the time was removed from the employee’s timecard
1. Click on the Time Card tab.
2. Double-click on the employee for whom the request was just denied.
3. Click SAVE on the time card to remove the hours. Verify after saving that the hours were removed.

List| Browse Exceptions | Browse Approvals | Global Approval | Global Re-Cale | Global Punch | Global Misc Pay | Configure Prox

Time Card:il tephen - Go Chirs
Search Dn: ime Card:Clark, Stephen - Google Chrome

Employ=e Mams

& lemplate-ministryworksevo.asureforcenelTinecard/InOulTimecar

kie ™

Achon ¥ Heip ™

Wndow ~

3 SMVE REFRESH CLOSE RECALC PUNCH TRANSFER MISCPAr ERASE DELET

Clark, Stephen

| Gomer, Sara Name | Clark, Stephen | ***

Calling. Sandra Comment |

Conley, Brian - -
Thu DB 6 Fibailf © Satoens @
Couk, Tyler T T
| CICCCN e
Gomett. Sasha T 1

B ozoorm [ [}

Crand

Manually Enter Leave Requests on a Time Card

There may be times that a supervisor decides to manually enter leave hours on the time card rather than using
the Leave Request method. This is not the preferred method for recording time. Click here for instructions for the

preferred method.
1. From the employee’s time card, click on the Misc Pay line. The Miscellaneous Pay information will open below.

2.
3.
4.
5.
6.

Click ADD ROW - a new line will appear at the top of the Miscellaneous Pay grid.

Under Day - change the date to the correct date (it will default to the first day of the pay period).
Under Pay Type - click the three dots; choose applicable pay type.

Under Hours - enter the correct number of hours.

Click SAVE.

Daparement 3 AN Poelod  0R/010023 - 08180000 5 ¢
m«m WOURLYFT - Hourly FT Employees

Sal 08113

Monok01 ® Tueoan: © | wedoapy & Thuosme @ Frdsos ® Satobos ®  Sunoan? ® Monooos @ | Tueeos © wedodo O Tmuoim @ Fnoanz @ B Sy
i soteu =] =] = = L) -] | = = = E =
o ceoew m|m | -] = = B | = = [} ] =
la L] = | = = = | | = = = B |
Out = -] - = = = = = = = = = -]
Mist: Pay
Total Hrs 0am
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Manually Delete Leave Requests from a Time Card

If leave request hours are manually added to the time card, they must also be deleted manually. They cannot
be deleted from the Leave Request tab.

1. From the employee's time card, click on the Misc Pay line. The Miscellaneous Pay information will open
below.

. Click on the miscellaneous pay row that needs to be removed.
3. Click DELETE ROW.
4. Click SAVE. The leave request hours will be removed from the timecard.

Fine
4 S i
WU repee—— i . Depastment 1 MiN mm m%mag_?u1 *
Mo 0801 @  Tee0BN: G Wed0s0s ®  Thuokn: O Fii 08105 Ssosme @  Swm0a0? & Monoska O TeeOlts @  wedoaho O Thuost @
I sooes =} a = m - B B = 2] ]
ow  wenoed = = | -] - = | = | ]
n = = = = = = = = ] = |
Out = = B | -] = = =] ] || |
Minc Pay I 800 PTO B 00 BEREAVEMIMT
Todad s qo I e e = LT G G = e T =
Fag Hre G404 Sy i = Shr e = = =2 o <
on -— - - - - - -— -— - -
[iir3 _ . . _ _ L . - . _
ans s i - — - — i - -
ot e e, — — — e Ths == e e =
[Prm Hrs. m . e - it = ga< o T -
Hce Hrs - —— - - —— e - - -
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Department Assignments

Change Department Allocation

If an employee forgets to transfer departments, the hours will need to be manually allocated on the time card.

1. Click on the clock icon - the entire day will be highlighted in gray, and the Time Detail will be
opened below.

0400 PM [ LT H = 10 | Leasenno

2. Click on the three dots under Department - a popup box will display.
3. Select the applicable Division, Branch or Department (or Team if applicable).
4. Click OK.
5. Click SAVE in the time card.
Allocate ALL hours to a different dept: Allocate a PORTION of the hours to a different dept:
5 .. 5 s s
oy e gt i | S
it @ Fi 2 @ T — sy [
L o rEE—— =0z — Sea
ou - e o - S
" -1 i e o = out
==l Q== = & O=-
] (4) " = = S
on - o = = =
| = = _ e Macowy  eomeioar
= ) = Tmowmvecos
Frm Hew —— — = _g i in Exdn | Oweln  Ouit Ex-Chut Owr-Out - Hows  Depesiment
Tiow O a7 070 A B B e [ | B 250 | Opessons|
wows QB wee @ B e [ = |_::r.—m|..
1
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Department/Team Summary by Time Card
To review the total hours worked by a department/team for a specific employee:

Go to the employee’s time card:
1. Click Action.
2. Click Time Summary.
3. Click Department/Team Summary.
4. A summary will be displayed. It totals all hours for each department.

If the totals do not seem accurate, you can make edits on the individual days.

Fie ™ Window ¥ Time Card: Clark, Stephen

Action ¥
Re-Allocation

SHVE REFRESH CLOS TRAMSFER MISC PAY ERASE DELETE CWRCHART WEEKWIEW TSREPORT VIEW MINS & Profile 5 Schedule
| Audit |

Clark, Stef

Department 3 : MIN Pay Period 08/16/2022 - 06/30/2022 5 < »

Name Global Approval Pay Group HOURLYFT : Hourly FT Employees

Comment Time Summary » Pay Type Summary (F3) I | -

| Transfer 5 ummary

Thu0616 ©  Fi DepartmentTeam Summary Sun 0619 ©  Mon0620 ©  Tue0821 ©  Wed0622 @ Thu06/2
In = 04:00 PM = [ [0 oz00pPm [ | oa00pPm
Out | rus:nu P [ os00Pm B | oso0Pm

R

. | L}
In - -
ow A =

Misc Pay

Total Hrs . 04.00 ) ) | 04.00 | ) | 04.00

Reg Hrs

Employee Clark, Stephen
For Pay Period Thursday, 16 June 2022 to Thursday, 30 June 2022

fision Branch Department | Regular | Other | ?v‘edimel 20ver1ime| gverﬁmel 40ver1ime| Premium | Total |
oo 200 3 2000 0.00 0.00 0.00 0.00 0.00 0.00 20,00
] 200 2 4.00 0.00 0.00 0.00 0.00 0.00 0.00 4.00

4
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Unlock Time Card to Allow Edits

Once a time card has been approved by either the employee or by management, edits will no longer be
allowed, including punches. The time card must be unlocked.

* Only administrators can unlock supervisor approvals.
* Administrators and supervisors can unlock employee approvals.

An example of a locked time card is listed below. Approval boxes are checked, and the time card is shaded, and
edits cannot be made.

iodl  OEQMI0ZE - OTETNI2 53 ¢ ¥
CAMCURLYPT - CA Maarly T Empltyass - Py

o | o s |1

|

Tk Frok2d @ Saoeas Sm0ld G Mos 0877 T O B weethod @ T & FroTol ® Swom O Seored O eoTes
" woA [ N = TR T || ] =] = B L |
on O T B vwm B [~ ] W mwm B otmoem [ ] =] (=] = -] -] [ ]
n wmm = = B o @ oxwm | ] | ] =] [~
o www B = = B e B ouom B = | =] = = =
In = = = ] = = | -] = = -] [
O | = = =] = E [ ] || [ ] m m
Totairs 0650 40 =0 oo 0650 = = = = = 7o
Fag Hix 0550 040 e L 0650 = = — == = =5

To Unlock:
1. Uncheck the boxes for Emp Approval and Sup Approval (as applicable).
2. Click SAVE. The time card is no longer shaded, and edits can be made.
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Remove Auto Lunch Deductions

If your ministry has rules built to have lunches automatically deducted from hours worked, you may find that
there will be times you need to delete this feature. Example: when an employee does not take a lunch.

From the employee's time card:

1. Click on the clock icon for the affected day. The entire day will be highlighted in gray and Time Detail
will open below.

2. Click on the three dots in the Ovr-Out column. A popup box will display.
3. Select Meal Override. This will remove the auto lunch deduction.

4. Click OK.

5. Click SAVE.

= I

Py Pese ORI - ORISR €
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Mobile App
Some employers want to offer their employees the ability to punch in via the app.
Information to know:

1. The employee must initially complete the sign in process to Asure Time & Attendance by either using the
ministry's assigned URL (MWxxxx.asureforce.net) or by logging in via Advanced HR (if applicable) prior to
downloading the app.

2. The app only works with the “Punch” or “Hours Entry” time entry techniques. Employee using the In/Out
Entry will not be able to use it.

3. Unique URL will need to be entered - https://mwXXXX.asureforce.net - XXXX will need to be replaced
with your ministry’s assigned #

4. In addition to recording time, the employees will also be able to see their accrual balances and create/
edit leave requests from the mobile app.

Employees will not be able to approve their own time card from the app. This can only be done via the URL.

6. Supervisors and administrators will not be able to approve their direct reports’ time cards and leave
requests via the app. This can only be done via the URL.

7. Employees will need to have the Light Mode setting turned on their phone in order to properly see the
font.

+ Go to Settings, then tap Display & Brightness
« Select Light to turn on Light Mode

8. The Asure Time & Attendance app can be downloaded via the Apple Store or Google Play. There are
multiple Asure apps, please be sure to select to correct one. At times, due to updates, the background
may change; however, the Asure 4l will always appear.

9. The app is created to time out frequently. To avoid having to continually log in, iPhone users can set up
facial recognition, while Android users can use fingerprint validation. The setting needs to be turned on
within the app and within the phone system settings.
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Employee Updates

Adding New Employees

New employees are initially entered via the Payroll or HCM platform. The information then synchronizes with
the Time & Attendance platform. A few fields that need to be updated in the Time & Attendance platform once
the synchronization is complete.

From the Profile tab, double-click on the new employee.
From the General tab:

1. Select the correct Time Zone Offset based on where the employee works.
a. Eastern: default

b. Central: -1
c. Mountain: -2
d. Pacific: -3

2. Select the appropriate Supervisor by clicking on the three dots. If a supervisor is not selected, the
default setting will direct all information to the administrator.

3. Pay Group - DO NOT EDIT THIS FIELD. This must be done via Evolution or the HCM platform; the
information will then synch to the Time & Attendance platform.

4. Accrual Group - DO NOT EDIT THIS FIELD. This must be done via Evolution or the HCM platform; the
information will then synch to the Time & Attendance platform.

5. Click SAVE.
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From the Access tab:

Update the Login ID to the ministry’s preferred format. The default is the employee number.

2. Theinitial Password is the word “default.” If the employee locks themselves out, click here for
instructions.

Note: If using the mobile app, employees must log in for the first time via the website to change
their password prior to logging into the mobile app.
3. Click SAVE.

Flie v Action v Help v

3 SAVE E AND NEW SAVE AND CLOSE REFRESH PREVIOUS NEXT

General
Employee Type
@Fmpln]me
O Supervisor
Ollanuger

() System User

Login

Allow Web Login

Login ID o |F“Wl'“’ﬁ |
Password 9 |""‘" @ |

Account Locked M
Employee Role
Role ‘ Employee
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Unlock Employee - Reset Password

If the employee unsuccessfully attempts to login in three times; they will receive a notification that their
account is locked. Only an administrator can change an employee profile.

1. Click on the Profile tab.

Double-click on the applicable employee.

From the popup, click on the Access tab.

Type a new Password - we suggest using the word “default.”

Uncheck the Account Locked box - as a default it will be checked because the employee is locked out.
Click SAVE. You will be taken to the General tab.

Mlmsuynl Protec Boseead 1 Abssi it Lt

B EEE S S S T B R ST S D S

o v A W

7. Click on the Access tab again.
8. Click on the FORCE PASSWORD RESET ON NEXT LOGIN button.
9. Notify the employee of the temporary password.

Acceoas Personncl Background
General o

Fmplayee Type
(_|Employee
@ Suparvisor
(Manager

() System Uscr

Login

Allow Web Lofin

Login ID ] whalabouttnisem aille |
Passwomd 1 . ] |
Account Locked m

MORGE NASSWORD RCSCT ON NOXT LOGIN

Note: If the employee uses the mobile app, they will have to log into the URL first to change their
password. Then they will be able to log back into the mobile app with the new password.
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Change Password
An employee has access to change their password at any time.

1. Click Preferences.

Patermcey | Lo O
Froust icensed to: My

R oo | ro | i § oo | sscisivoon | vina | wisen | on § ocots J comomton | '

A Set User Preferences screen will be shown.
2. Complete the Change Password fields.
3. Click OK.

Set User Preferences - Google Chrome = ] b3

@ lemplate-ministyworksevo.asureforcenet/sellings/userpreferences.aspafid=18198e5c-... & Q
et User Frelerences

Specify your prefer
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Ect the calendor week begin date
W Yes ' No

Use week beqin dale

et the default sort option on employee list

Emplovee hist sort ophion Employes Name A

Set the default view of Supervisor Home Page on load
@® Show I Hide

Information Section

$€1 the confhirmation options
Gonfinm exit O Yes ® No

Cindim e CYes ® Nu
Confirm save on exitichange ®Yes O Ne

Change Password

Gurrent Password =

New Password 9

Confirm Password

Set the number of records on each page

Mumber ol Heconds 4P

B e
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Supervisor Setup
If the supervisor is not an employee in Time & Attendance, contact your Payroll Processor.

Click on the Profile tab.

Double-click on the applicable employee.

Click on the Access tab.

Select Supervisor under Employee Type.

Click SAVE. You will be taken to the General tab.
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(continue to next page)
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Click that on the Access tab again.

Verify the employee’s email address populated in the Email ID box.
If it doesn't, click SELECT RECIPIENTS. A popup box is displayed.

9. Click ADD.

10. Enter email address and click OK.

© N o

11. Click OK again. You will be taken to the Access tab.
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12.From the Access tab, click on SELECT next to Security Access. A popup box will be displayed.
13. Click on the Role tab.

14. If the employee should be an Administrator, select Client Admin; otherwise, leave as the default, Supervi-
sor.

MinistryWorks*

el daga i = 94T 45-Coha4a2E- BISH- TEceied0l2

HIAdT a5-cofa-4a78- b5 TABcc e 02 T RownFro.. €

15. Click on the Access tab.
16. All will be selected as the default - DO NOT CHANGE.

17. Limit Access to Direct Reports - this box enables the Supervisor to only see their direct reports, as
designated on the employee’s Profile tab.

+  The box should be checked for Supervisors.
*  The box should be unchecked for Administrators.
18. Click SAVE AND CLOSE until you are back to the employee’s Profile tab.
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Secondary Supervisor Setup

If a second supervisor needs to be added to employees, follow all Supervisor Setup steps (pp. 39-41) thru #14,
then continue below:

15. Click on the Access tab.

16. Select By Employee.

17. Click on the SELECT button.

18.To select multiple employees, use Ctrl + Click.
19. Click OK.

20. Click SAVE AND CLOSE.
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Workflow Notifications

A workflow notification can be created so that supervisors and/or employees are sent automated emails re-
minding them to do specific tasks or prompting them with FYl info (e.g. approve time cards or a missed punch).

The initial step is to create the message that will be sent.
1. Click on the Configurations tab.
2. Click on Workflow Notifications - Organizational Configuration.
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3. Double-click on the type of notification to be created.
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4. Enter your custom message.
5. Click SAVE AND CLOSE.
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Once the message is created, the actual workflow notification needs to be created.

Click on the Configurations tab.
Click Workflow Notification.
Click New Notification.

Select a notification type.

ik W

Click OK. The new workflow notification setup will be displayed.

MinistryWorks® o

] e e [ | oo

6. Onthe General tab, enter a Title for the notification.

7. The Message Text will pre-populate with the message that was just created.
8. Check the box for Send notification as E-Mail.

9. Inthe Scheduling area, select Recurring.

10. Click SCHEDULE.

11.0n the Set Recurrence screen, customize when the message should be sent.
12. Click OK.

13. Click SAVE AND CLOSE.
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14.0n the Employee Selection tab, the All Pay Groups and All Hierarchies will be checked as default.

15. If you want to have the rule only apply to certain pay groups, uncheck All Pay Groups and select the
applicable pay groups from the popup box.

16. Click OK.
17.Click SAVE AND CLOSE.

@ template-ministryworksevo.asureforce. net/WarkFlowNotif WorkFlowNotification aspx 2wintype=Unapproved... &

Pay Group - Google Chrome =T o
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Setect Group

SAVE
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|| Minors Only

@ ] A Pay Groups
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Reports

Leave Request Status Report

This report can be pulled to view all leave requests for a specific time frame. This report can be used to check
that all approved leave requests are reflected on the time cards.

1. Click on the Reports tab.
2. Click on Benefit Time. Feel free to explore this area to see if additional reports will be beneficial.
3. Click on Leave Request Status Report.

Schedubs | Time and Attenda Perzonnel | Labor Analysis | Bonefit Time | Configuration | Favorites | User Defined tempadmin | () Hitp On The Page | Get Suppart

Benefit Time Reports e

Laave Fiques! $tabus Ripon ACusieamre]
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Timg O Reason Code Repon (Casnmice]
Nime O fnasn Coste Rport . meidept & Teama Only Eastomize]
Laave Request Auda Rapon
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Expiting Accruals Repori (Cusomits]
o Paid Hours Repor

Accrust Audit Report [

Meerusl Ralances with Vikse
Mccrul Curment Batance Repori with Fuium Reguests Iusioemize]

Level Filters - default is All but can be broken down into department reports.
5. Employee Filters - default is All Employees but individual employees can be selected.

6. Date Range - default is the Current week; but it is we suggest that you look at either the Last Period or
the Current Period.

7. Click RUN REPORT.

Level Filters Employee Filters
o~ 0™

oy

A Date Range
o . [
2 m

The Leave Request Status Report will be displayed. Go to each individual employee’s time card to confirm the
approved leave requests are reflected.
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Pay Period Comments Report
This report can be pulled to view all comments that have been made by employees for a specific time frame.

1. Click on the Reports tab.
2. Click on Time and Attendance. Feel free to explore this area to see if additional reports will be beneficial.

3. Click on Pay Period Comments.
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Level Filters - default is All but can be broken down into department reports.
5. Employee Filters - default is All Employees but individual employees can be selected.

6. Date Range - default is Current week; but it we suggest that you look at either Last Period or Current
Period.

7. Click RUN REPORT.
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The Pay Period Comments report display. Review to see if action is needed.
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Audit Reports
There are several audits that you can pull to see what happened, by whom, and when it occurred.

Time Audit Report

Reports tab >Time and Attendance > Time Audit Report
This audit shows details about the punches for all employees, including the location of each punch.

R Time Audit Report
PR ioma
ity 3, 20 - g 3. 05
= T - T v ]
[— Bianch 5. 34 Braneh B SEURA
Empiagen 0 1317 e
“ooroe oRooan: o Bymen Tima T oeotmm wooamgT osonnm oA B
ovinzoz e it e T 1 ey 2700 anLZeE e Py e
mvmonz e 08 Burcn s varr e 10300 0T Qa2 b 30 A ot
“asnam Tocann A P T Tam meamm seieumer oanzates e o e
“mmm “rsoan [T 1 “aevam T3 ‘e zzan B
e ahss o Sk e i e saszz 3883 0w PrenermrAeer 2zec
[ee——— Branen 24 Dranch 1 B0u84 Company 10- WATI
Ereparpee 10 1531 [Ty ——
o T e T
P ovoara rzeana
oz armen ir2mane
Tavmnzes oaea o i
e Coweman e
sma e 2w
] a3am TEman
) e e Tama
sataaes arerm “rasasn
ssmzz ot rwmans

A time card audit can also be generated on an individual employee’s time card.
1. Click Action.
2. Click Audit.

4 Profile [ Schedule
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The audit will display.
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Leave Request Audit Report
Reports tab > Benefit Time > Leave Request Audit Report

This audit shows details about all leave requests.

. Lears Begueat Audh Regart =
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A leave request audit can also be generated on each individual leave request.
1. From the Leave Request tab, double-click on a specific leave request.
2. From the popup, click on Action.
3. Click Audit.

[mnawa |5
==

T st v A B 0l P
ety o et gy B Datn
nd Doy

The audit will display.
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Profile Audit Report

Reports tab > Personnel > Profile Audit Report

This audit shows details about the employee’s profile setup in Time & Attendance. Most of this information will be
synchronized from “api” (user name column), which means that it was pushed from other MinistryWorks platforms.
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A profile audit can also be generated on each individual's profile.
1. From the Profile tab, double-click on a specific employee.
2. From the popup, click on Action.
3. Click Audit.
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The audit will display.
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